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I. COURSE OVERVIEW: 

This course will also provide the computer aided design laboratory provides a strong foundations of computer 

aided designing tool and students will learn the implementation of solid modelling using CATIA. It enables 

students to master the fundamentals of advanced modelling techniques, sketcher tools, base features, drafting, 

sheet metal and surface design workbenches. This course focuses on giving the foundations of engineering design 

and making it very useful for getting the student ready for product manufacturing industry. 
 

II. COURSE OBJECTIVES: 

  The students will try to learn: 

I. The principles of isometric and orthographic conversions to create CAD models using CATIA software. 

II. The profiles and subsequently generating three dimensional entities from the generated profiles. 

III. The fundamentals of geometric dimension and tolerances and representing those using designing 

software’s. 

IV. The build various aircraft parts by selecting workbenches appropriate for designing those components. 

 

III.. COURSE OUTCOMES: 

   After successful completion of the course, students should be able to: 

CO 1 Choose appropriate tools and profiles for developing the required sketch using the Sketcher 

workbench. 

CO 2 Make use of wireframe elements, surfaces, trim elements and power copies for constructing the 

complex surfaces. 

CO 3 Utilize different geometric and dimensioning symbols and industry standards for the preparation 

of technical mechanical drawings. 

CO 4 Select appropriate tools available in assembly workbench for creating three-dimensional 

assemblies incorporating multiple solid models 

CO 5 Build components using sketch Based features, perform sheet metal operations and correctly 

organize the tree for having maximum compatibility for editing or modifying the model 

CO 6 Develop a model from drawing provided and draw conclusions for designing various aircraft 

components by utilizing different workbenches. 
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a. Pad command 

b. pocket command 
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a. Dress up features  
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a. Assembly 

b. Add 
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d. Experiment example 
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a. Dynamics analysis  

b. Experiment example 

 

       13. DESIGN OF LANDING GEAR         30 

a. Experiment example 
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b. Case 2 tapped wing  
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EXERCISES FOR COMPUTATIONAL AIDED AIRCRAFT 

PRODUCTION DRAWING LABORATORY 
 

Note: Students are encouraged to bring their own laptops for laboratory practice 

sessions. 

 

1.1 INTRODUCTION TO CATIA V5 

CATIA (an acronym of computer aided three-dimensional interactive application) developed 

by the French company Dassault Systems  

 

CATIA is a powerful tool for designing complex parts and assemblies. It allows mechanical 

engineers to create 3D models and generate 2D drawings with accuracy and precision. It 

provides tools for sketching, modelling, and draf2ting that enable the design of components 

with intricate details.  

• Installation of CATIA V5 

• Understand the CATIA interface 

• Interface and Tools 

• Precision and Accuracy  

• 2D and 3D Modelling 

• Collaboration and Sharing  

• Customization 

• Industry Usage 

• Versions and Licensing 

  



 

CATIA INTERFACE (GUI) 
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View Toolbar 

 

Fig.no:.2 

 

 

  



 

Other Commonly used tools 
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1.2: Getting Started with Sketcher workbench 

The Sketcher workbench is a set of tools that helps you create and constrain 2D geometries. 

Features (pads, pockets, shafts, etc...) may then be created solids or modifications to solids 

using these 2D profiles.  

The Sketcher workbench contains the following standard workbench specific toolbars.  

 

Fig.no:4 

• 1.3 Profile toolbar: The commands located in this toolbar allow you to create simple 

geometries (rectangle, circle, line, etc...) and more complex geometries (profile, spline, 

etc...). 



 

Fig.no:4 

 

• 1.4 Operation toolbar: Once a profile has been created, it can be modified using 

commands such as trim, mirror, chamfer, and other commands located in the operation 

toolbar.  

• 1.5 Constraint toolbar: Profiles may be constrained with dimensional (distances, 

angles, etc...) or geometrical (tangent, parallel, etc...) constraints using the commands 

located in the Constraint toolbar. 
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2: SKETCHER 

Part design is used to create 3D models from the basic 2D sketches created in sketcher 

environment. 
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Some of the commands in workbench explained below: 

2.1.1 PAD command: This command adds material in the third direction, a direction 

other than the sketch. 

2.1.2 POCKET command: The POCKET commands somehow the opposite of PAD 

command. It simply helps remove geometry belonging to an already create part. 

2.1.3 SHAFT command: SHAFT command is mostly used to make shaft like parts. It 

requires an axis, around which the sketch will be revolved. 

2.1.4 RIB command: This command adds material along a guide curve. RIB is used to 

make components like springs, pipes etc. 

2.1.5 SLOT command: SLOT removes the material along a guide curve. This ensures 

that the cross section will be uniform throughout.  

  



3: Part Design 

Part Design -1: Sketched based features, exit workbench, Dress up features 

3.1 Dress-Up Features 

Dress-Up Features are used to add finishing touches or functional elements to a 3D model. 

These are applied to existing solid geometries and are essential in mechanical part modeling. 

Common Dress-Up Features: 

Feature Description 

Fillet Rounds the edges or corners of a solid to reduce stress 
concentrations. 

Chamfer Bevels the edge of a part at an angle for aesthetics or function (e.g., 
assembly). 

Shell Removes material from a solid, leaving a thin wall (creates a hollow 
part). 

Draft Adds a taper to the faces of a part to facilitate removal from a mold 
(useful in plastic parts). 

Thickness Adds or subtracts a uniform thickness to/from a face or body. 
Edge Fillet / Variable 
Radius Fillet 

Allows different fillet radii along an edge. 

3.2. Reference Elements 

Reference Elements are used to define geometry that helps construct or constrain the main 

design but is not part of the final part geometry. 

Common Reference Elements: 

Element Description 

Point Used to define locations for features, sketches, or patterns. 
Line Helps in sketch creation or defining axis of rotation/symmetry. 
Plane Used to create sketches, mirror features, or define sections. 
Axis Acts as a centreline for revolutions or patterns. 
Surface Serves as a base or guide for other operations like sweeps. 
Geometrical Set A container for organizing reference geometry in Part Design. 

3.3. Transformation Features 

Transformation Features are used to modify or replicate existing geometry to create 

repetitive or symmetrical patterns. 

Common Transformation Features: 

Feature Description 

Translate Moves a body or feature in a straight direction. 
Rotate Rotates features or bodies around an axis. 
Symmetry Creates a mirrored copy of a feature or body. 
Mirror Mirrors features or entire parts about a plane. 
Scale Scales features by a defined ratio. 



Rectangular Pattern Repeats a feature in rows and columns. 
Circular Pattern Repeats a feature in a circular arrangement. 
User Pattern Repeats features based on custom geometry like points or curves. 
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Try: 

1. Create the “Swivel. CAT Part” Using Multiple Sketches 

Part Design -2: 

 

Fig.no:8 

 

Try: 

1. Modify the dimensions and design the sketch using CATIA 



4. BOOLEAN OPERATIONS 

Boolean operation is an important feature in CATIA V5.  

Types of Boolean operations include Assemble, Add, Remove, Intersect, Union Trim, and 

Remove Lump. 

4.1Assemble: The Assemble command basically works considering the polarity of the solid 

bodies. 

4.2 Add: Add operation removes only the intersected portion between two bodies so that 

both parts act as a single body irrespective of the polarity of the bodies. Here, the bodies may 

be with positive polarity or negative polarity or a combination of both. 

4.3 Remove: Remove operation removes the selected body first and then is merged with the 

second body irrespective of the polarity of the bodies.  

4.4 Intersect: To derive a single body from two different bodies, Intersect Boolean operation 

is used. Basically, the intersected portion is the output which is displayed as a single body. 

There is no effect of polar bodies here. 

4.5 Union Trim: Unwanted material can be removed from any two bodies by using Union Trim 

operation which results in a single desired body. 

4.6 Remove Lump: Remove Lump Boolean operation removes the lump inside the body. 

During the operation, a tab will give the option to the user to keep/remove any face as 

required. Using this Boolean operation, a user can remove N number of lump face areas. 

4.2 Exercises on Boolean Operations 

Boolean Operations:  

Fig.no:9 

Try: 

1.Creating the Bottom U-Joint using Boolean Geometry. 



5: Sheet Metal Design 

5.1 Sheet metal design is used for modifying sheet metal parts created, not to be used to 

create new sheet metal parts. 

5.1.1Walls on Edge: This command creates a wall from edges of an existing part 

5.1.2 Cut-outs: Additional possibilities are now available when creating a cutout: We can 

choose a direction for the cutout that is different from, or equal to, the normal 

direction. 

5.1.3 Stamping: Stamping also called pressing involves placing flat sheet metal, in either coil 

or blank form, into a stamping press. In the press, a tool and die surface form the metal 

into the desired shape. 

5.1.4 Bending: This command bends based on a line or by giving an Angle 

5.1.5 Rolled Walls: This command shows how to create rolled walls (such as pipes etc). 

 

5.2 Exercises on Sheet Metal Design 

Model a Metal Bracket: 
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Try: 

1. Change the number of holes, location and find the maximum stress concentration, strain 

and displacement.  

2. Fix the left side of plate and apply compressive loads on other three sides and find the 

maximum stress concentration, strain and displacement. 



6: Surface Design 

Surface features introduce additional flexibility to a model. Surfaces can be used to define a 

complete part or to integrate a complex shape into the solid part (in the Part Design 

workbench). 

6.1.1 Surfaces: The product and industrial designers these days are giving importance to 

product styling and providing a unique shape to components. Generally, this is done 

to make sure that the product looks attractive and presentable to the customer. The 

shape of products is managed using the surface modelling techniques. Surface models 

are three-dimensional models with no thickness and unlike solid models, they do not 

have mass properties. CATIA V5 provides several surface modelling tools to create 

complex three-dimensional surface models. 

6.1.2 Operations: Generally, the surface models are a combination of various surfaces. You 

need to join, trim, split, or translate the surfaces to manage multiple surfaces. CATIA 

provides a number of such operation tools that can be used on the surfaces created 

using the tools discussed earlier in this chapter. Some of these operations are discussed 

in the following section. 

6.1.3 Wireframe: The wireframe construction elements aid in creating surfaces. The sketches 

drawn in sketcher workbench can also be used to create surfaces. 

6.1.4 Replication is a powerful modelling tool used to repeat an existing surface feature (such 

as a rib, hole, or patch) along a defined path or pattern without manually copying and 

repositioning it multiple times. 

6.2 Exercises on Surface Design 
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Try: 

1. Use the aluminium as material and find the natural frequency for same beam.  

2. Take a simply supported beam made of mild steel and find the natural frequency. 

  



7: Assembly 

Assembly environment is used to provide mating to two or more-part models to from 

complete assembly 
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7.1 Main Assembly Tools in CATIA: 

Tool Description 

Insert Component Adds new parts or sub-assemblies to the main assembly. You can insert 
empty parts or existing .CATPart/.CATProduct files. 

Constraints Defines positional and orientation relationships between components 
(e.g., Coincidence, Contact, Angle). 

Move Component Moves parts freely or with respect to defined axes; includes 
manipulation with compass. 

Fix Component Fixes a component in space to serve as a reference for other parts. It’s 
usually the first part you insert. 

Exploded View Creates exploded views for visualization and documentation, showing 
how parts fit together. 

Sectioning Allows sectional views of assemblies to inspect interior fits and 
interferences. 

Measure Tools Measures distances, angles, and clearances between parts. 
Clash Detection Checks for interferences (hard or soft) between components. Helps in 

fit-checking. 
Bill of Materials 
(BOM) 

Generates a list of parts in the assembly. 

Product Structure 
Tree 

The left-hand tree shows the hierarchy of components, making it easier 
to navigate and manage complex assemblies. 

Constraints Defined 
in Workbench 

These include: 

7.1.1 Coincidence Constraint  

Purpose: Aligns two geometrical elements so they lie exactly on top of each other. 

Elements Used: Faces, edges, planes, axes, points. 



Usage: Commonly used to align holes, shafts, surfaces, or axes of cylindrical parts. 

Example: Aligning a bolt with a hole — the bolt’s axis is made coincident with the hole 

axis. 

7.1.2 Contact Constraint 

 Purpose: Ensures two surfaces touch each other but do not allow interpenetration. 

Elements Used: Planar, cylindrical, or spherical surfaces. 

Usage: Used to define a physical “touch” — ideal for simulating real part contact. 

Example: Bottom of a washer contacting a flat surface on a bracket. 

 

7.1.3 Offset Constraint 

Purpose: Maintains a fixed distance between two faces or elements. 

Elements Used: Parallel planes, surfaces, edges, etc. 

Usage: Useful when a gap or space is required between two parts. 

 Example: Keeping a 5 mm gap between two parallel mounting plates. 

 

7.1.4 Angle Constraint 

Purpose: Maintains a specified angular relationship between two surfaces or axes. 

Elements Used: Planar faces, axes, or edges. 

Usage: Useful for assembling parts at defined angles. 

Example: Assembling a handle at 30° to a base plate. 

 

7.1.5 Fix/Unfix Constraint 

Purpose: 

 Fix: Locks a component in place — it cannot be moved. 

 Unfix: Unlocks a fixed component, allowing it to move or be re-constrained. 

Usage: Typically the first part in an assembly is fixed, serving as a reference frame. 

Example: Fixing the base part of a machine to build the rest of the assembly around it. 

 

Gear Constraint 

Rack and Pinion Constraint | 

 

7.1.6 Common Assembly Constraints: 

Constraint Function 
Coincidence Aligns two surfaces or axes. 
Contact Ensures surfaces touch but don’t interfere. 
Offset Maintains a specific distance between two surfaces. 
Angle Maintains a specified angle between faces or axes. 
Fix Locks a component in space. 

 

 



7.2 Exercises on Assembly 

Assemble a Knuckle Joint 
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Try: 

1. Instead of temperature apply heat flux on the sides of square and find the temperature 

distribution.  

2. Introduce a hole at the centre of square and find the temperature distribution 

  



8: GD & T 

8.1 geometric dimensioning and tolerancing (GD&T): a unique set of GD&T symbols are used 

to define the relationships between part features and measurement references. Designers and 

engineers utilize this international language on their drawings to accurately describe part 

features on the basis of size, form, orientation and location. 

8.1.1 Types of Tolerances: 

Tolerances define the acceptable range of variation in a dimension. 

Type Description 

Form Tolerance Controls the shape (flatness, straightness). 

Orientation 

Tolerance 

Controls angular relationships (perpendicularity, parallelism, 

angularity). 

Location Tolerance Controls position (true position, concentricity). 

Runout Tolerance Controls rotation-related variations (circular & total runout). 

 

8.2 Exercises on GD & T 

8.2.1GD & T (Cantilever Beam): 

A cantilever beam with length of 550 cm and cross section area of 100 mm2 subjected to 

nonlinear load. Find the deflection and nonlinear behaviour.  

Try: 

1. Use a cantilever beam with same length as stated in above problem but with circular cross 

section and find its nonlinear behaviour.  

2. Use the same cantilever beam subjected to torque and find its nonlinear behaviour 

9: Drafting 

Drafting is a process of generating 2D machine drawing for the 3D part models to send it to 

the manufacturers. 

9.1.1Views in Drafting: 

Views represent different projections of the 3D model on a 2D sheet. 

View Type Description 

Front View The main reference view of the part. 

Top/Bottom View Shows depth/height from above or below. 

Side Views Shows right or left face of the object. 

Isometric View 3D-like pictorial view for better visualization. 

Section View Displays internal features by "cutting" through the object. 

Detail View Enlarges a selected portion of another view for clarity. 

Auxiliary View Shows inclined or complex surfaces not visible in standard 

views. 

Broken View Shortens long parts in a view without changing scale. 

 



Catia drafting is of two types 

9.1.2 Interactive Drafting: Interactive Drafting in CATIA allows users to create 2D drawings 

manually, without linking to any 3D part or assembly. It is used for drawing sketches, 

symbols, schematics, or layout plans that are not based on a 3D model. 

Key Features: 

• No dependency on a 3D model. 

• User creates lines, arcs, circles, dimensions, text manually. 

Good for: 

Electrical or piping schematics 

Flow diagrams 

Conceptual layouts 

Sketch-based documentation 

9.1.3 Generative Drafting: Generative Drafting automatically generates 2D views (front, 

side, section, etc.) from a 3D part or assembly. The views are associative, meaning changes 

in the 3D model will update the drawing automatically. 

Key Features: 

Fully linked to CATPart or CATProduct files. 

Automatically creates: 

Orthographic views 

Section views 

Isometric views 

Detail views 

Includes dimensioning and annotations based on model geometry. 

Ideal for production-ready technical drawings.

 

 

 



 

9.2 Exercises on GD & T 

Drafting (Cantilever Beam): 

A cantilever beam made of mild steel as following specifications L=150 cm, b=10cm, h=10cm 

shown in Figure below is subjected to a periodic force, which is mathematically represented 

below. The amplitude of the force is 1000 N. F = 1000k sin (pi*t/4). Find the deflection of beam. 
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Try  

1. Repeat the above analysis for simply supported beam.  

2. Change the magnitude of periodic load and repeat the same analysis. 

 

  



10 : Design of Aircraft Wing 

Exercises on Design of Aircraft Wing 

Design of Aircraft Wing 

To model a 3D aircraft wing that includes the airfoil profile, sweep, taper, twist, and span, 

typically used in aerospace structures. 

 

10.1. Preparation & Inputs 

Before starting: 

• Know your airfoil profile (e.g., NACA 2412). 

• Define: 

Wing Span (e.g., 20 m) 

Chord Lengths (Root & Tip) 

Taper Ratio 

Sweep Angle 

Dihedral Angle 

Twist Angle 

You can obtain airfoil coordinates from airfoiltools.com or import from Excel or .dat file. 

 

 10.2. Step-by-Step Process 

STEP 1: Sketch Airfoil Profiles 

Workbench: Sketcher (inside Part Design or Generative Shape Design) 

Import or draw airfoil profiles at root and tip locations. 

Place sketches on planes separated by the desired wing span. 

Apply scaling for taper and rotation for twist. 

STEP 2: Position Sketches in 3D 

Workbench: Wireframe and Surface Design 

Create planes at different span stations using spacing. 

Insert airfoil sketches at each plane location. 

Use Affine Transformation or Scaling tool for taper. 

Use Rotate for twist. 

https://airfoiltools.com/


STEP 3: Create Wing Surface 

Workbench: Generative Shape Design 

Use Multi-section Surface tool: 

o Select airfoil sketches (root to tip). 

o Add guide curves if necessary for smoothness. 

Output is a 3D surface wing. 

STEP 4: Thicken Surface (Optional) 

Use Thick Surface to convert surface into a solid body. 

This is useful if structural design or FEA is intended. 

STEP 5: Add Wing Features (Optional) 

• Add elements like: 

Winglet 

Flap track fairings 

Wing box or ribs 

Use Part Design tools: pad, pocket, boolean operations. 

 

Useful Tools and Features: 

Tool Workbench Purpose 

Sketch Sketcher Airfoil creation 

Plane Wireframe Positioning sketches 

Multi-section Surface GSD Lofting wing geometry 

Affine Transformation GSD Scaling (for taper) 

Rotate GSD Apply twist 

Thick Surface GSD Convert to solid 

Pad/Pocket Part Design Add details 



10.3 Bonus: Visualization 

You can create a Drawing in Drafting Workbench to show: 

• 3-view wing layout 

• Airfoil profiles 

• Dimensions and annotations 

 

10.4 Summary Workflow 

1. Import or sketch airfoils. 

2. Create spanwise planes. 

3. Position and scale/twist airfoil sketches. 

4. Use loft (multi-section surface). 

5. Thicken or refine model. 

6. Add structural or control surfaces (optional). 

7. Draft or simulate (if required). 

10.2 Exercises on Aircraft Wing 

 

10.2.1 Dynamic Analysis (Model analysis of wing)  

Perform model analysis of an aircraft rectangular wing of a span 100 cm and the chord length 

of wing is 10 cm and cross-sectional area is 100 cm2. Calculate the natural frequency of wing.  

Try: 

 1. Repeat the above analysis for a tapered wing. 

 2. Repeat the above analysis for tapered wing with uniformly varying load  



 

Fig.no:15 

11: Design of Fuselage Dynamic Analysis (Model analysis of 

Fuselage) 

11.1. Objective: 

To model an aircraft fuselage with internal structures such as: 

• Frames (Bulkheads) 

• Longerons & Stringers 

• Cabin Floor 

• Doors & Windows 

• Seats (optional) 

• Equipment bays or cargo areas 

 

11.2. Fuselage Design Workflow 

 STEP 1: Define Fuselage Layout 

Workbench: Sketcher + Wireframe and Surface Design 



• Define cross-sectional profiles (circular, oval, or custom) at various fuselage 

stations. 

• Create planes along the fuselage longitudinal axis using specified spacing. 

• Sketch cross sections on those planes. 

Tools: Sketch , Plane , Spline , Circle , Ellipse  

 

 STEP 2: Create the Outer Fuselage Skin 

Workbench: Generative Shape Design 

• Use Multi - Section Surface  to loft between the cross-sectional sketches. 

• Smoothen curves with guide lines if needed. 

• Optionally use Sweep or Blend  for nose and tail shaping. 

Tools: Multi - section Surface , Join , Trim , Sweep, Blend  

 

STEP 3: Thicken the Surface 

Workbench: Generative Shape Design 

• Use Thick Surface  to convert skin to a solid body, typically with 3–5 mm thickness 

depending on scale. 

 

11.3. Internal Components Design 

 Frames (Bulkheads): 

• Create planes at multiple fuselage stations. 

• Sketch ring shapes or ovals matching internal contour. 

• Use Pad to give thickness. 

 Sketch , Pad, Pocket  

 

 Stringers & Longerons: 

• Create lines or guide curves along the fuselage length. 

• Use Rib  or Sweep with a small cross-sectional sketch to form stringers. 

 Rib , Sweep, Sketch , Offset  



Cabin Floor / Cargo Floor: 

• Add horizontal planes inside the fuselage. 

• Sketch and pad floor panels. 

 

Windows & Doors: 

• Create cut-outs using sketches on outer skin. 

• Use Pocket  tool to cut windows, doors, and hatches. 

 

 Seat & Equipment Bays (Optional): 

• Design simple blocks or imported 3D components. 

• Use Assembly Design to position them. 

 

11.4. Assembly (if modular) 

Workbench: Assembly Design 

If each component (skin, frames, floor, seats) is separate part:Assemble them using 

constraints: 

Coincidence  
Contact  
Offset  
Fix  

 

Summary Table 

Component Workbench Tool Used 

Fuselage Skin GSD 
Multi-section 

Surface 

Frames Sketcher + Part Design Pad, Pocket 

Stringers/Longerons GSD + Part Design Sweep, Rib 

Doors/Windows Part Design Pocket 

Floor Sketcher + Part Design Pad 

Assembly Assembly Design Constraints 



11.2 Exercises on Design of Fuselage  

Calculate the deformation of the aluminium fuselage section under the application of internal 

load of 100000 Pa. The radius of fuselage is 0.15m and thickness is 2 mm. 
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 Try  

1. Repeat the above analysis for a monocoque fuselage.  

2. Repeat the above analysis for a monocoque fuselage with both internal and external load. 

11.2: Dynamic Analysis (Model analysis of Fuselage)  

11.2.1  STEPS FOR MODAL ANALYSIS 

 

STEP 1: Prepare the 3D Fuselage Model 

• Ensure the fuselage geometry is solid (thickened) and clean (no surface gaps or 

errors). 

• Include important structural parts: 

o Frames 

o Stringers 

o Floor 

• Exclude small, non-structural parts like seats, windows, etc., unless necessary. 

 

 



STEP 2: Switch to Analysis Workbench 

Workbench: Generative Structural Analysis  → Create a New Analysis Case 

• Select Modal Analysis as the study type (not static or buckling). 

• The part will be automatically linked to the analysis environment. 

 

STEP 3: Apply Material 

• Go to: Insert > Material > Apply Material  

• Select appropriate aluminum alloy or composite material from the library. 

• Ensure properties like: 

o Density 

o Young’s Modulus 

o Poisson’s Ratio 

o are defined (essential for modal analysis). 

 

STEP 4: Define Mesh 

• Use Automatic Meshing (Tetrahedral mesh). 
o Insert > Mesh  

o Choose global mesh size (adjust for accuracy). 

• For thin-walled fuselage, consider using Shell Elements (if designed that way). 

 

STEP 5: Apply Boundary Conditions 

• Apply Restraints where the fuselage is connected to other components (e.g., wing 

box, empennage). 

o Example: Use Clamp  or Fixed  at base frame. 

o Use Slider  if limited movement is expected. 

• Modal analysis doesn’t need external loads — only mass and stiffness affect natural 

frequency. 

 

STEP 6: Set Analysis Parameters 

• Go to Insert > Frequency Case  

• Define: 

o Number of modes to extract (e.g., 6–20) 

o Frequency range (e.g., 0 to 500 Hz) 

 



STEP 7: Run Analysis 

• Click Compute from the toolbar. 

• CATIA will calculate: 

o Natural frequencies 

o Mode shapes 

 

STEP 8: View Results 

Use: 

• Image > Deformation  to see mode shapes. 

• Frequency List  to view exact natural frequencies. 

• Animate mode shapes to study the vibration behavior visually. 

12.2 Exercises on Dynamic Analysis (Model analysis of Fuselage) 

Calculate the natural frequency of the aluminium fuselage section under the application of 

internal load of 100000 Pa. The radius of fuselage is 0.15m and thickness is 2 mm.  

Try 

 1. Repeat the above analysis for a monocoque fuselage. 

 2. Repeat the above analysis for a monocoque fuselage with both internal and external load. 

 

  



12: Design of Nose Cone 

12.1 Exercises on Design of Nose Cone  

A simple retractable landing gear subjected to a load of 10000 N. Find the deformation and 

stress developed in the landing gear 
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Try  

1. Repeat the above analysis for a landing gear subjected to compression load.  

Perform model analysis of A simple retractable landing gear subjected to a load of 10000 N. 

Calculate the natural frequency of wing.  

Try: 

1. Repeat the above analysis for a landing gear subjected to compression load.  

2. Repeat the above analysis for tapered wing with uniformly varying load. 

  



13 Design of Landing Gear  

13.1 Design of Landing Gear 
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Ansys Composite PrepPost (ACP) find the Interfacial delamination between fiber and resin, 

Rupture of fibers in a Carbon fiber reinforced polymer composite having 10 layers and 

subjected to tensile load of 100N.  

Try: 

1. Repeat the above analysis for Ceramic matrix composite. 

2. Repeat the above analysis for Carbon fiber reinforced polymer composite subjected to shear. 

  



14. DESIGNS OF AIRCRAFT STRUCTURES. 

Design of any two types of Aircraft structures. 

14.1 Structure 1: Aircraft Wing 

14.2 Case 1: Rectangular Wing 

Problem Statement: 

Perform modal analysis of an aircraft rectangular wing. 

Span: 100 cm 

Chord Length: 10 cm 

Cross-sectional Area: 100 cm² 

Material: Aluminum (assume density = 2700 kg/m³, Young's Modulus = 70 

GPa) 

Assume cantilever boundary conditions. 

Tasks: 

1. Derive and calculate the first natural frequency using Euler-Bernoulli beam theory. 

2. Plot the first mode shape. 

3. Comment on the wing flexibility and resonance characteristics. 

 

14.2.2 Case 2: Tapered Wing 

• Geometry: Taper ratio = 0.5 (tip chord = 5 cm, root chord = 10 cm) 

• Use equivalent cross-section assumption. 

Tasks: 

1. Perform modal analysis as in Case 1. 

2. Compare the first natural frequency with the rectangular wing. 

3. Discuss how tapering affects dynamic response. 

 

14.2.3 Case 3: Tapered Wing with Uniformly Varying Load 

• Apply a linearly varying distributed load from root to tip (max at root). 

Tasks: 

1. Analyze deflection shape under load. 

2. Perform a dynamic analysis incorporating load-induced stiffness variation. 

3. Comment on changes in mode shape and frequency. 

 

 



14.3 Structure 2: Aircraft Fuselage Frame 

14.3.1 Case 1: Circular Frame (Section of Pressurized Fuselage) 

• Geometry: Circular ring with diameter = 150 cm, cross-section area = 75 cm² 

• Material: Titanium alloy (density = 4500 kg/m³, E = 105 GPa) 

• Fixed at both ends (model section of fuselage) 

 Tasks: 

1. Perform free vibration analysis for the fuselage ring. 

2. Calculate fundamental frequency. 

3. Discuss how stiffness and mass affect vibration. 

 

14.3.2 Case 2: Oval Fuselage Section 

• Semi-major axis = 160 cm, Semi-minor axis = 120 cm 

• Use equivalent stiffness approximation. 

 Tasks: 

1. Perform modal analysis of the oval fuselage frame. 

2. Compare dynamic response with circular frame. 

3. Discuss implications on aircraft comfort and fatigue. 

 

14.4 Structure 3: Aircraft Empennage (Tail Boom) 

14.14.1 Case 1: Horizontal Stabilizer Beam 

• Span: 60 cm 

• Cross-section: Hollow circular, outer dia = 8 cm, inner dia = 6 cm 

• Material: CFRP (Carbon Fiber Reinforced Polymer) 

• Fixed at fuselage junction 

Tasks: 

1. Calculate natural frequencies and mode shapes. 

2. Analyze effect of material anisotropy on dynamic response. 
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